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“Any sufficiently advanced technology is indistinguishable from magic” 

-​ Isaac Asimov 
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Introduction​

5th Dimension is a strategic world builder and RPG MMO that empowers players to 

compete in a story-driven battle to create and then control the virtual world of 5th 

Dimension.  

Within this world, players build, buy and sell robotic A.I. agents called ‘Mechs’ that they 

control to compete in an array of high-intensity competitions and Esports tournaments. 

Set within a rich, sprawling fantasy universe, the virtual world of 5th Dimension is unlimited 

in scale and is created by the community of players and creators who populate it using a 

sandbox style, world building interface, the ‘5th Dimension World Builder’ (referred to 

herein as the 5D Builder).  

The 5D Builder operates as a companion app to the 5th Dimension game, and functions 

as a level designer and game content creation tool that’s used in tandem with the core 

game, thus empowering players to craft and create the game world of 5th Dimension as 

they see fit. 

This document provides a guide for users on how to operate the 5D Builder and also 

summarizes its utility during the early access stage of the product lifecycle.​

 

​
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The 5th Dimension World Builder v1.0​

​

Overview ​

Using the 5D Builder, players and content creators are empowered to craft beautiful, 

triple-A quality game environments. Once created, players can publish their environment 

on one of any available build locations within the game’s world map by purchasing a 

license called a ‘Deed’ which empowers them to add their environment to the 5th 

Dimension game world.​

​

Once added, the player’s environment forms a permanent and concrete part of the 

game’s geography and exists as part of the game. ​

​

In future releases a community voting system will be employed to determine which 

environments actually make it into the game, however during early access its first come, 

first served.​

​

Once an environment is built, it then becomes available to any other player of the World 

Builder to enter and move around inside, exposing the builders’ work for all the world to 

see.​

​

Version 1.0 is a single player game, however in the near future an updated release will be 

made available that incorporates multiplayer features including in-game voice / audio.​
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Early Access Strategy​

During early access which is scheduled to end in Q1 2026 (please note this date is subject 

to change) the 5th Dimension World builder gives community members the ability to 

collaborate to create and design the virtual world of 5th Dimension, effectively 

crowdsourcing the build of the 5th Dimension game world.​

​

Early Access is divided into stages in accordance with the game’s published road map, 

which can be found here: https://5thdimension.gg/roadmap/​

​

In the first stage of early access the World Builder will be accessible to players prior to the 

release of the game. In this way we aim to build a community of passionate builders and 

players who cooperate with our team to build out the core game world together, ahead of 

the alpha and beta game release.​

​
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Esports & Prizes​

As early access progresses, an alpha iteration of the game will be made available, with 

the alpha release scheduled for Q2 2022. The playable area in this iteration will be strictly 

limited however will include a selection of the environments made by community 

members with the World Builder.​

​

Immediately upon the release of the Alpha, Esports tournaments will begin using a 3rd 

person shooter style game experience, offering up to $10,000 in prizes per month. Esports 

gameplay will take place across the game world, including in the environments (also 

referred to as Esports ‘venues’) built by community members. The latest anti-cheat 

software from Steam will be integrated with the game alpha to ensure fairness for all 

players. ​

​

Approximately 20% of the total prize pool will be divided between the owners of the 

environments (aka venues) that are used by players to compete. The more frequently 

players decide to use a certain venue for match play, the larger the share of the prize pool 

earned by the venue owner will be. More detailed information about the exact process for 

calculating venue prizes will be published in future iterations of this app and will also be 

made available via the 5th Dimension website: www.5thdimension.gg​

​
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Steam Workshop 

When the 5D Builder is released on Steam in Q1 2025 following Steam’s review process , it 

will be interoperable with the Steam Workshop and players will be empowered to publish 

their Environments via our Steam Workshop page and make them available for sale and 

community review.​

​

Special Events​

During the alpha release of the 5th Dimension game (above) selected venues will also 

host live music events including DJ sets and MC battles, using the game’s motion capture 

service which empowers creators to control avatars live in real time using a 

camera-based motion capture system that animates avatars within the 5th Dimension 

game world. ​

These performances will coincide with Esports tournaments, whereby music performers 

will appear and perform live, in-world during Esports tournaments and provide a live 

soundtrack to the Esports gameplay.​

​
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3D Models 

When working with the 5D Builder, players gain access to a library of high quality 3D 

models and environmental assets to empower them to easily craft rich, beautiful worlds 

with ease.​

​

3D models included in the 5D Builder library are provided by Kitbash, arguably the gaming 

industry’s best producer of triple-A game environment assets. Kitbash 3D models and 

game content assets are regularly used by some of the world’s best game studios and 

appear in many of the most played triple-A game titles. To ensure our community gets 

the very best building tools possible, we’ve selected an array of the finest Kibash assets 

for use within the 5D Builder.​

​

Find out more about the Kitbash product range at www.kitbash3d.com 

Players can also craft their own 3d models from scratch using the Unity Pro Builder 3D 

modelling app which is directly integrated with the World Builder’s Environment Editor 

interface (see below). 
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Quick Start Guide​

​

To get started using the 5D Builder, begin by following the steps below. At any time you 

can get help and support from our team via our Discord server ​

​

https://discord.com/invite/5thdimension​

​

​

Installation​

​

To get started using the 5D Builder, begin by downloading and installing the application 

package from our Itch.io page https://realityjam.itch.io decompress / extract the 

downloaded folder and run the application file labelled World Builder, no installation is 

required.​

​

​

​
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Minimum System Spec​

​

Your PC must have a 64-bit Windows 11 OS. Your CPU should be at least an Intel i3-4150 or 

Ryzen 3 1200 (AMD). The game requires a minimum of 4GB RAM, although more is 

recommended. The minimum GPU requirement is Geforce GT 730, Radeon R7 240 with 

4GB VRAM, however a higher GPU spec is recommended, ideally Nvidia GeForce RTX 2080 

or better. We do not support Mac OSX, Linux or Mobile platforms at this time.​

​

Create Your RealityJam Account​

​

The 5th Dimension World Builder operates in tandem with the RealityJam platform. 

Various functions of the World Builder require you to be logged into your RealityJam 

platform account.  

Others, such as 5th Dimension’s quests system and game item marketplace are available 

only on RealityJam. The 5D Builder and the 5th Dimension core game combine with the 

RealityJam platform to form a software ecosystem designed to maximize the quality of 

player experience. Click the link below to create your account:​

​

https://realityjam.io/login?app=5thdimension​

​

Create Your First Environment​

​

After signing in to your RealityJam account return to the 5D Builder and navigate to the 
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‘My Venues’ page using the left hand nav bar, and get started designing your very own 

piece of the 5th Dimension game world. 

Click the ‘+’ symbol on any one of the 3 environment slots available to launch the World 

Editor interface to begin creating, please continue reading below for instructions on how 

to use the World Editor to create beautiful 3D environments. Each player is limited to 

owning a maximum of 3 Venues within the game world to avoid individuals hoarding real 

estate. 

​

​

​
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User Interface 

The 5D Builder application is accessed using the navigation bar, displayed on the left side 

of the UI which is used to navigate between pages within the app.​

​

The World Map Page​

Click the button labelled World Map in the left hand nav bar to reveal a map of the 5th 

Dimension game world, which comprises 5 islands that float in a sea of primordial energy 

known as ‘Prana’. Find out more about the game’s geography on the 5th Dimension 

website at this link​

​

Clicking the hexagonal waypoint marker for each island opens a detailed map of a given 

island. In the first release of the game only one island is available for development, the 

island of Utara.​
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Utara Island Map Page 

The detailed map of the island of Utara displays the 3 major cities that exist on the island, 

the capital Neotokyo, and 2 regional cities, Magmoria and Apocrypha. In the current 

release, only the city of Neotokyo is available for development, the remaining 2 cities will 

be opened for development in future releases of the 5D Builder. 

Clicking the hexagonal waypoint marker for the city of Neotokyo opens a map of the city.​

​

​

​
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Neotokyo City Map​

The city map of Neotokyo displays the city’s regions and districts, each of which is 

available for development. Each district is divided into 3 regions as follows;​

​

Inner City - densely populated interior of the city and also its central business district​

Mid Metro - the city’s inner urban zone, immediately beyond the inner city, a mix of 

business and more upmarket residential real estate development​

Outer Limits - the industrial zone, a mix of industrial buildings and lower value real estate 

development​

​

Each region is divided into 3 districts that are labeled according to the district naming 

convention above.​

​

At the centre of the city map is Neotokyo’s ‘Battle Arena’ hub, a wide expanse of formed 

terrain and customized structures used for the activation of competition combat events 

known as Battles. 
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Clicking on any of the regions in the map reveals the Region Browser on the right side of 

the screen as shown below. 

 

The Region Browser reveals a list of all the Venues (or built Environments) that are 

available in that region. Available build locations are displayed with a green label, and 
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build locations upon which an Environment has been built are displayed accordingly. 

Clicking the Enter button for a Venue opens it, empowering players to move around inside 

the Venue and tour its interior. 

The process for publishing and building environments so that they become available to 

enter via the Region Browser is described below. 

There are 1110 available build locations in the city of NeoTokyo and the number of 

locations is limited per region. The number of available locations per region as shown 

below is the same for each of NeoTokyo’s 6 districts.​

​

Inner City - ​ 37​

Mid Metro - ​ 55​

Outer Limits - ​ 93​

​

After these regions are consumed by built Venues, new cities will be made available in 

future releases of the 5D Builder, however NeoTokyo’s identity as the very first city in 5th 

Dimension game world to be built and populated will always hold special significance 

within the game’s lore and storyline and the builders of Neotokyo will always be 

recognized as the originators of the 5th Dimension game world.​

​
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My Venues Page​

​

The My Venues page displays the 3 environment slots available to each player. Players 

are limited to creating / owning a maximum of 3 Venues to avoid individuals hoarding 

real estate due to the fact that the available number of build locations within Neotokyo is 

capped at 1110. 

The first time the My Venues page is loaded the 3 available slots will display in the Empty 

status, as indicated by the red label, showing that design work has yet to begin. 

​

​

 

To begin designing your piece of the game world, click the plus button on the toolbar. 

Following this you’ll be asked to name your Venue, add a thumbnail image and save by 

clicking the Create button. The thumbnail image will centre and scale any image added, 
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however for best results use a 9x16 aspect ratio image at 150 pixels per inch resolution, 

PNG or JPEG file format. 

​

​

​

​

​

​

 

 

After creating your new Venue, the status label will change from Empty to Draft, denoted 

by a yellow label. Once in Draft status, the Venue’s toolbar will display 3 new icons as 

shown below: 

​

 

18 



 
 

Launch Button 

The Launch button opens the World Editor interface to empower the player to 

access the 5D Builder’s 3D environment design tool set to design an environment 

which, when complete may be published as a Venue, or in the near future, 

uploaded the Steam Workshop for sale and voting.​

​

Edit Button  

The Edit button empowers the player to change the name and thumbnail image 

for each environment they create. 

​

Publish Button​

​

The Publish button empowers a player to change the status of an environment 

that is completely designed to prepare it to be added to the 5th Dimension 

game world. Publishing an environment is the first step in the process to build a 

Venue within the game world so that it becomes visible in the Utara city map 

and available to other players to enter and experience. Publishing an 

Environment requires the builder to spend a Deed (see below). When published, 

the status label will change from Draft (yellow) to Published (green). 
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​

​

 Deeds Counter 

The Deeds counter displays the number of Deeds owned by a player. Deeds may 

be purchased from the RealityJam platform when logged in (see below) 

 ​

​

Deed Refresh Button​

​

The Deeds Refresh Button refreshes the number of Deeds available to a user 

after they have been purchased from the RealityJam platform (or the Steam 

Store following release on Steam). If after purchasing a Deed the counter does 

not increase to display the number of Deeds owned as expected, click the 

Refresh button to update the counter and the correct number of Deeds will be 

displayed. 
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Environments, Deeds & Venues​

The 5D Builder empowers players to design and create playable game environments 

which, once completed, can be published and then built as Venues within the 5th 

Dimension game world.​

 

Venues​

​

Venues are made available as a permanent part of the game world within which 

competition Esports matches will be activated when the game’s alpha and Esports 

tournaments are launched in Q2 this year.​

Venue owners share in a monthly cash prize pool of up to $5,000 with the more popular 

Venues that log the most play time during Esports producing the greatest share of the 

rewards pool.​

Prizes are distributed on the last Friday of each month based on a weighted distribution 

whereby the more time that players have spent inside a particular Venue during Esports 

events in that month, the greater the share of rewards will be for that particular Venue.​

Venues that are not frequented by any players in a given month will not be eligible for a 

share of the rewards pool.​

At the end of each month, a leaderboard will be produced ranking every Venue in 5th 

Dimension by popularity i.e. by total play time.​

The more players spend time inside a Venue during Esports, the higher the share of 

rewards that Venue will produce.​
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​

Deeds​

​

To publish a Venue, players must first purchase a Deed from the Utara city council which 

gives them ownership of their preferred build location within the city limits.​

Deeds are key to a player’s ability to build their environment and establish it as a Venue 

for Esports gameplay so that it forms a permanent part of the game world.​

Players may purchase Deeds by logging into the 5th Dimension app on the RealityJam 

platform at the link below and clicking the Environments link in the left hand nav bar​

https://realityjam.io/5thdimension​

​

​

​

Deeds are purchased using 5th Dimension’s in-game currency, Dimens, and cost $15.00 

(or 4000 Dimens) each. Players purchase Dimens using the payment service available via 

the RealityJam platform at the link below using credit or debit card via Stripe, or using any 

major cryptocurrency via the Radom Network Web3 payment service. ​

https://realityjam.io/deusx/on-ramp​

​

To use the RealityJam payment service, players must create a digital wallet within which 

to store their Dimens using the Metamask Chrome browser extension. Once created, 

players must connect the wallet to RealityJam to use it to store their Dimens and to 

access the payment service. Install the Metamask Chrome extension at the below link, ​
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https://chromewebstore.google.com/detail/metamask/nkbihfbeogaeaoehlefnkodbefgp

gknn​

​

Once installed, navigate to the dashboard page of your RealityJam account and click the 

‘Connect’ button in the user interface as shown below.​

​

​

After connecting your wallet, you’ll be able to quickly and easily purchase Dimens tokens 

to get yourself a Deed.​

​

As described above, owners of Venues will share in a monthly cash prize pool of up to 

$5000 from the launch of 5th Dimension game alpha in Q2, accordingly they are priced at 

$15.00.​
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Building Your Environment​

​

The steps required to design and publish an environment and then build it into a publicly 

available Venue are as follows;​

​

1. Log into your RealityJam account 

2. Create an environment in Draft status as described above. 

3. Purchase a Deed from the RealityJam platform (or, in future versions of the 5D Builder, 

from the Steam Store)​

​

4. Click the publish button marked with a tick in the given environments toolbar on the My 

Venues page as shown below, after this is done, you will be asked to confirm that you 

want to purchase a Deed to publish your venue as once a Deed is used it is consumed 

and can’t be refunded. ​
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​

PLEASE NOTE: ONCE AN ENVIRONMENT IS PUBLISHED IT WILL NO LONGER BE AVAILABLE TO 

EDIT AND CANNOT BE CHANGED OR ADDED TO. PLEASE ENSURE THE DESIGN WORK WITHIN 

YOUR ENVIRONMENT IS 100% COMPLETE AND THAT YOU ARE SATISFIED WITH ITS DESIGN 

BEFORE PUBLISHING AS THIS STEP CANNOT BE UNDONE.  

5. Following the consumption of a Deed, the environment’s status will change from Draft 

to published, indicated by a green label.​

​

6. Using the left nav bar, navigate to the NeoTokyo city map and select a region within 

which to build your newly published environment. Select any build location marked as 

‘Available’ and click Build.​

​
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7. Your Environment’s name and thumbnail image will then appear in the list of Venues 

within the selected region, click the Enter button to enter your Venue and move around 

inside it. Your environment has now become a Venue available for any players of the 5D 

Builder to experience. It will exist forever as part of the game world of 5th Dimension, you 

have now secured ownership of your piece of the 5th Dimension sci-fi universe. 

​
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World Editor​

The 5th Dimension World Editor is 3D content creation, 3D modeling and level design app 

used to craft and create the game world of 5th Dimension.​

​

The editor is built on the Unity Game Engine and operates on the same basic principles as 

Unity. The Editor UX and UI follows the same basic logic flow as the Unity game engine, 

however is much simpler and more compact than Unity, empowering regular game 

content creators to get access to the power of Unity, without the need for any domain 

knowledge of, or experience using the Unity Game Engine. ​

​

The toolset available via the Editor includes an array of scripts and prefabs designed to 

help you create scenes and game levels for the 5th Dimension game. The Editor leverages 

Unity’s Universal Render Pipeline.​

​

PLEASE NOTE: This user guide is intended to provide a general overview of the key 

features of the World Editor to empower players to design and create environments, it is 

not an exhaustive instruction manual detailing the functionality of every single feature 

of the World Editor. As we progress through early access, an array of educational 

materials will be published including more finely detailed instruction manuals, master 

classes and tutorials.​

​

Please begin with the Getting Started section for an overview of the Editor and its features. 
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Getting Started 

1.​ Launch the World Editor by clicking the launch button shown below​

​

​

 

2.​ On launch a new Environment will be created with one ‘default’ scene. Environments 

consist of one space within which player experience manifests called a Scene, 

however players can create multiple scenes to allow them to prototype different 

designs without destroying their existing work, creating near limitless creative 

freedom during the design process. ​

If using multiple scenes during the design stage. ​

Please note: players must ensure they delete any unwanted scenes before 

publishing as only one scene can be included within a published environment. 

​

 

​

​

​

​

​
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​

 

 

 

 

 

 

 

The standard ‘default’ scene contains a single camera which is used to position the 

players point of view, a directional light and a skybox, and these objects (along with 

any others you add) are common to any scene you create and are displayed in the 

Hierarchy on the right side of the screen.​

​

PLEASE NOTE: WITHOUT AT LEAST ONE LIGHT AND CAMERA OBJECT ADDED, THE 

ENVIRONMENT WILL NOT BE VISIBLE, DO NOT UNDER ANY CIRCUMSTANCES PUBLISH A 

VENUE WITHOUT THESE FEATURES AS ITS FEATURES WILL BE INVISIBLE TO OTHER 

PLAYERS. 

3.​ Press the "Play" button in the top toolbar to see the game world at runtime. ​

​

​

​
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​

The runtime view of the game world is then displayed at the foot of the screen, the 

editor at the top. To view the gameplay full screen, click the full screen button at the 

top right of the player window.​

​

​

​

​

​

​

​

​

​

​

​

 

4.​ Import some 3D models for use in the scene. In the File menu, click Import Assets, 

select the Addressables folder and then select the assets you’d like to import, after 

importing they will appear in the Project window on the right hand side. ​

 

5.​ Drag your newly imported 3D models into the scene and get to work creating your 

environment.​
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Windows 

Scene 

The Scene window is the primary visual interface for editing and designing content within 

each environment and contains the various game objects (including lights, cameras, VFX 

and 3D models) used in the design process 

Game 

The Game window appears when the Play button in the top toolbar is clicked and displays 

the environment as it will appear when it is ‘played’ by other users (players). This is like the 

viewing the ‘finished product’ that is produced by the work you do in the Scene window. 

Hierarchy​

​

Displays a list of all the game objects present in the Scene, click on an object to display an 

array of detailed information and editing options in the Inspector 

Inspector​

​

The Inspector provides a host of detailed technical information and also various editable 

parameters for each of the game objects in the Scene and the Hierarchy windows. 

Project  

The project contains a list of each scene in our environment and the 3D models you’ve 

imported for use in the Scene. 
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Console ​

​

The console window contains a chronological list of code line commands that are 

produced via the changes that you make in the Scene, you can think of this as a way of 

looking ‘under the hood’ to understand what’s happening at the code level when using 

the World Editor, including a list of any errors that occur when using the Editor.​

​

Animation 

The Animation window allows players to create rich complex animations, bring the 3D 

models they import to life. Animations can be applied to game objects in a wide variety of 

ways to help bring static spaces to life.​

​

Builder​

​

Empowers players to create and texture their own 3D models from scratch and then insert 

them into the Scene (see below for more information) 
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Navigation 

Navigation in the Scene window is controlled by the mouse, scroll wheel, and the AWSD 

keys on your keyboard.​

​

Scroll wheel - Zooms in / out​

Right Mouse button - hold to activate navigation​

Mouse - control the direction (point of view) of the camera​

AWSD - directional navigation (while the right mouse button is held)​

Left Mouse button - select an object in the scene​

​

PLEASE NOTE: The content displayed in the Play window is controlled by the position of 

the camera in the scene, to change the point of view of the play window, move the 

camera in the Scene. 

​

​

Game Objects​

​

Game objects are the assets used in the environment design process to create a 

playable game environment, these are added to the scene to provide you different 

functionalities and tools to aid in the design process.​
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Positioning​

​

Control the position of each game object in the Scene by clicking and dragging the 

directional controls to move the object along its X, Y and Z axis (back, forward, up and 

down)​

​

​

​
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Rotation​

​

Rotate objects using the rotation tool in the top toolbar, select the object, click the rotate 

button and adjust along 3 axes.​

​

​

​

Cameras 

In order to display or view the content in a scene, a camera must be added to the scene. 

The position of the camera in the scene allows you to simulate navigation and inspect the 

model at runtime using Play mode. 
3D Objects​

​

3D Objects are imported (as above) and made available via the Project Window. Once 

inserted (dragged and dropped) into the Scene they appear in the Hierarchy and 

Inspector windows. Basic shapes can also be added to the Scene from the Game Object 

Menu. By selecting the Mesh Renderer in the Inspector, basic shapes can be given realistic 

textures to help transform them into usable environment assets.​

​

Players can also create their own 3D objects from scratch using the Unity Pro Builder app 

(see below)​
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​

Lights​

​

Lights allow the objects in the environment to be illuminated. Each light inserted the Scene 

has an array of properties that can be edited in the Inspector window. 3 different types of 

lights are available directional, spot and point, each offering different methods of lighting 

the objects in the Scene​

​

​

​

​
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3D Asset Library 

To access the Environment Editor’s library of 3D models, you must first import them using 

the Import Assets command in the File Menu to open the Import Browser. ​

​

​

Click Select to open the default addressables folder, select the items you wish to Import 

and click Import.​

​

The selected imported objects will appear in the Project Window on the right side of the 

screen and can then be dragged and dropped into the scene.​

​

Pro Builder​
The Environment Editor integrates Unity’s ‘Pro Builder’ 3D modeling software, allowing you 

to create your own high quality 3D Models from scratch.​
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​

Access the Pro Builder application by clicking the ‘Builder’ item in the Window Menu. A 

detailed instruction manual for the Pro Builder application is available at the link below:​

​

https://docs.unity3d.com/Packages/com.unity.probuilder@4.0/manual/index.html​

​

​

​
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Top Toolbar​

​

​

​

Play​

​

Plays the Scene (as described above) 

Hand Tool 
​
Allows you to drag the point of view of the Scene window and when used in combination with the 
right mouse button allows you to quickly and easily navigate inside the Scene 
 
Move Tool​  
​
Moves objects in the scene using the directional controls (as above)​
 
Rotate Tool​
​
Rotates objects in the Scene 
​
Scale Tool​
 
Extrudes objects, enlarges or shrinks objects in the Scene​
​
​
​

39 



 
​
Global Rotation​
​
Switches global rotation on and doff 
​
Tool Handle Position​
​
Controls the position of the tool handle for selected objects​
 

Boundary Limits​
​
The size of each environment is limited to a maximum ‘workable’ space or geographic 
area. The boundaries or limits or this workable are are defined in the Scene by the red 
boundary limits marker. Content positioned outside the boundaries will be automatically 
deleted from published environments. 
 
 
 

 
​
​
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​
Saving Scenes 
 
 
Each Scene within an environment can be saved and reopened as required. Click the Save Scene 
item in the File Menu before exiting the World Editor to save your work. If you fail to save your work 
you will lose it! 

 
Memory Profiler​
​
The Memory Profiler gives players a real time view of the size and performance of their 
environment as they create it.​
​

All environments that are published in 5th Dimension MUST conform to a maximum GC 
(graphics card) memory count of 4GB, environments that exceed this size limit may 
negatively the performance of the game and its owner will be asked to modify it to 
reduce its size or risk having their Venue removed from the game. ​
​

​

​

 
 
 
 
 
 
 
 
 
 

41 



 

Animation 
The Animation window allows game objects in the scene to be animated using the 
Animation Timeline Editor. The Animation tool set will not work while playing. Stop Play 
mode by selecting the stop item from the Edit Menu.​
​

To begin, select the game object you want to animate and create a new animation clip. 
Add properties to define the position, scale and rotation of your animation.  Use the 
timeline to drag and drop triggers that define new stages of the animation and edit the 
values you wish to change to create the desired animation.​
​

​

​

 
 
 
 
 
 
 
 
 
 
 
– 
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5th Dimension is published by Virtual Reality Jam Ltd, all rights reserved. ​
5th Dimension, the 5th Dimension logo, mark and typeface are registered trademarks of 
Virtual Reality Jam Ltd, 86 - 90 Paul St, London UK EC2A4NE. ​
​

For more information or to join the 5th Dimension community find us on the web at 
www.5thdimension.gg.​
​

For licensing, media or business development inquiries email info@vrjam.com.​
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